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Abstract
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We have developed protocols for rapidly quantifying the band intensities from nucleic acid chemical
mapping gels at single nucleotide resolution. These protocols are implemented in the software SAFA
(Semi-Automated Footprinting Analysis) that can be downloaded without charge from
http://safa.stanford.edu. The protocols implemented in SAFA have five steps: 1.) Lane identification,
2.) Gel rectification, 3.) Band assignment, 4.) Model fitting, and 5.) Band intensity normalization.
SAFA enables the rapid quantitation of gel images containing thousands of discrete bands, thereby
eliminating a bottleneck to the analysis of chemical mapping experiments. An experienced user of
the software can quantify a gel image in approximately 15 minutes. Although SAFA was developed
to analyze hydroxyl radical (·OH) footprints, it effectively quantifies the gel images obtained with
other types of chemical mapping probes. We also present a series of tutorial movies that illustrate
the best practices and different steps in the SAFA analysis as a supplement to this protocol.
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Introduction
Chemical mapping of nucleic acids (‘footprinting’) provides structural information at
nucleotide resolution. Chemical probes provide unique structural detail. As examples, hydroxyl
radicals (·OH) probe the solvent accessibility of the nucleotide backbone1-5 while a chemical
§To whom correspondence should be addressed. phone: (518) 486 4103, Fax: (518) 474 3181, e-mail: alain@wadsworth.org.
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modifier such as dimethylsulfate can identify exposed base moieties that are base-paired6, 7.
Boundaries of single stranded regions, as well as an estimate of their flexibility, can be obtained
by chemical probing using the SHAPE chemistry8-10. The importance of chemical mapping
to RNA and DNA structural analysis stems from the ease with which nucleic acid polymers
are separated by size using gel electrophoresis. Chemical mapping is thereby often used to
follow structural change in response to titrated changes in equilibrium solution conditions (such
as Mg2+ concentration)11-14 or as a function of time3, 15, 16. Such quantitative mapping
experiments require the analysis of large numbers of gels. Software tools that assist in the
analysis of this cornucopia of information in a standardized manner are thus needed.
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Figure 1A illustrates a gel image based on a typical chemical mapping reaction carried out on
a large structured RNA molecule. ‘Protections’ from the chemical probe are observed with
increasing Mg2+ (the bands get lighter) and are characteristic of the RNA folding. Singlenucleotide band fitting algorithms allow an accurate estimation of the relative intensities of
each band in the gel using a deconvolution procedure17, 18. This deconvolution procedure
effectively corrects for errors in observed band intensity that are the result of peak overlap.
Figure 1B illustrates the result of this deconvolution procedure for one of the lanes in the gel;
a series of individual peak models (shown in light gray) are fit to the profile of the lane (black
line). The SAFA procedure allows a user to quantify a gel image using a single nucleotide
fitting procedure in a semi-automated way18. This protocol describes the steps to be taken to
obtain quantitative and reproducible data from a gel image using SAFA (Figure 1A).
Single nucleotide peak fitting algorithms require initial guesses for the peak positions in each
lane17, 18. Most gels, however, are not sufficiently uniform to easily transfer assignments of
bands from one lane to the next. Therefore, we implemented a gel rectification procedure
(Figure 2) that allows users to geometrically correct gel images in a standard and semiautomated fashion so that band assignments are uniform across the gel. This procedure
enhances the accuracy and reduces the tedium of quantifying all the band intensities of each
gel. This procedure also allows SAFA to average the band signal for each lane, resulting in a
more robust quantification of the band intensity.
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The expected outcome of a SAFA analysis is illustrated in Figure 1. A digitized gel image is
input into SAFA. SAFA rectifies the lanes and bands to remove geometric distortion (Figure
1A) and fits a peak model (Figure 1B) to accurately quantify the individual peak intensities
(Figure 1C)18. The procedure is semi-automated so that an experienced user can quantify an
entire gel image in about 20 minutes. Obtaining highly reproducible results requires some
experimental planning (discussed below), as the layout of the lanes on the gel can greatly
facilitate gel rectification. The inclusion of sample replicates allows the reproducibility of the
data to be estimated.
Accurate gel quantitation is a key step in the analysis of chemical mapping reactivity data. In
applications to structural modeling, thermodynamic titrations, or time-resolved kinetic
experiments, the resolved band intensities must subsequently be normalized post-quantitation
for subsequent quantitative analysis. We therefore include in this protocol instructions on using
the data normalization approaches implemented in SAFA for ·OH footprinting. A user should
be able to efficiently and reproducibly quantify a gel image using the approach outlined below.
While the example developed in this protocol is based on a thermodynamic analysis of the
folding of an RNA molecule using ·OH, the quantitation methodology is independent of the
experimental modality. Published studies demonstrate the generality of SAFA in structural,
thermodynamic, and kinetic studies of nucleic acids with a variety of chemical probes10,
19-21. Structural analyses of nucleic acids include ·OH Footprinting, and chemical mapping,
which respectively report the solvent accessibility and the extent of base-pairing, at either a
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rough (DMS mapping) or fine level (SHAPE mapping)6, 22. These techniques can be used to
assess thermodynamic and kinetic parameters for nucleic acid molecules by monitoring
changes in the relative protections as a function of a reaction coordinate (e.g. salt concentration)
or time13, 15, 23, 24. The core algorithms in SAFA are being adapted to analyze highthroughput chemical modification data from capillary sequencers as well two-dimensional
nucleic acid gels for mapping contacts in large RNA molecules. In the spirit of the RNA
Ontology Consortium25, we continue to develop SAFA with the goal of accommodating the
needs of the users of the full range of available chemical mapping methods. Beyond an alreadyfacilitated quantification of diverse nucleic acids probing and mapping experiments, future
versions of SAFA will include multiple normalization options such as normalization to one
particular band8 or by pairwise comparison19.

MATERIALS
Equipment Setup
Computational Requirements
• Versions of SAFA have been compiled to run on the Mac OS X (10.4 or higher, PPC/
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Intel) and Windows XP operating systems. The different versions of the software,
along with the source code can be downloaded gratis from http://safa.stanford.edu.
Specific installation instructions are provided in the software documentation for the
different architectures. SAFA has been tested on a variety of platforms; we
recommend a system with at least 2GB of RAM and a recent Pentium processor. A
three-button mouse is also useful for both Macintosh and PC versions, but not
required.
•

•

SAFA reads as input either ImageQuant (Molecular Dynamics Inc.) .gel files or
standard .tiff images. When using SAFA in conjunction with image analysis software
other than ImageQuant it is important to obtain the highest bit-depth possible (e.g.,
16-bit images should generally be used). See step 1 for guidelines regarding the layout
of the gel.
SAFA also requires a nucleotide sequence file in FASTA format that corresponds to
the sequence of the nucleic acid polymer being studied. Example files are available
for download at http://safa.stanford.edu.

PROCEDURE
Pre-analysis experimental planning
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1| Run the gel referring to the following layout guidelines. Careful layout of the lanes in
the gel improves the accuracy of the resolved peak densities due to the nature of gel
rectification. Figure 3 illustrates the recommended layout of a gel. Three types of lanes
are expected: (a) Sequencing Lanes: These lanes guide band assignment. They generally
have a dark band at a particular residue type. For example an RNA T1 digest will produce
a dark band for every G in the sequence. Running sequencing reaction lanes for more than
one nucleotide may be necessary for mapping methods such as SHAPE10; (b)
Background Lanes: These lanes contain unmodified RNA and help estimate the amount
of background cleavage that has occurred during the chemical mapping experiment; and
(c) Data Lanes: These lanes contain the experimental data. In the case of a titration, each
lane corresponds to the profile for a particular concentration of solute in the series of
concentrations. In other experiments, these may contain pairwise comparisons of the
mapping in presence or absence of an influencing solute or thermodynamic variable.
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We strongly recommend that experiments be replicated, ideally with independently prepared
samples, to assess the error in the final quantitated values.
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Importing the gel image and sequence files
2| Open SAFA by clicking on its icon or by typing “SAFA” in the command line window
of Matlab. The sequences and gel files are imported by clicking on the “Load Sequence”
and “Load Gel” file buttons on the main SAFA window (Figure 4A), respectively.
3| Define “crop” boundaries immediately after loading the gel image by left clicking and
dragging in the main window. To quantify independently several portions of the same gel
image (e.g. samples loaded at different times), the user will need to upload the image as
many times as there are sections to be quantified.
4| Import the sequence file by clicking on the “Load Sequence” button. Sequences no
longer than 500 bases should be loaded. Therefore, the sequence file should slightly exceed
the number of bases that are expected in the gel image. The numbering assigned to the
input sequence can subsequently be adjusted to match the conventional numbering used
in the literature for the molecule. The user specifies whether the gel involves 5′ or 3′ labeled
nucleic acid fragments, i.e., whether the fragments with faster electrophoretic mobility
correspond to smaller or larger residue numbers, respectively.
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<CRITICAL STEP> Once the sequence is loaded, a Sequence Dialog appears (Figure 4B).
This Sequence Dialog defines the behavior of the semi-automated band assignments (Section
4). Selecting a base (A, C, G, U or T) will highlight it on the sequence that is displayed. It is
recommended to select the nucleotides in the sequence that correspond to bands in the ladder
or sequencing lane(s). Therefore, if a T1 digest is used, “G” should be selected. First time users
may want to select all bases, which will require them to manually select each band until they
become comfortable with the software.
Gel Rectification
5| Identify lane boundaries by clicking on the “Define Lanes” button in the SAFA main
window (Figure 4A). Draw the left most lane boundary on the gel image by left clicking
(the middle button and right button undo and terminate the boundary). After defining the
first lane boundary, the user may revise the boundary by typing “r.” After selecting at least
two lanes, typing “g” will generate and show the programs ‘guess’ for the next lane
boundary. Figure 2A shows a completed lane boundary selection on a typical gel image.
Typing “Z” will vertically rectify the gel image as illustrated in Figure 2B. SAFA allows
the user to export the rectified gel image as a tiff for archival purposes.
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6| Click the “Anchor Lane” button to define the reference lane for horizontal rectification
of the gel. The user should select a central lane in the gel for this purpose.
7| Click on the “Align Gel” dialog to define band anchor lines spanning the horizontal
width of the gel as shown in Figure 2C. Three to four anchor lines distributed evenly over
the length of the gel are typically sufficient to rectify the image (Figure 2D). More lines
may be necessary for severely or non-uniformly deformed gels.
<CRITICAL STEP> Zooming in and out of the gel image during anchor line definition by
right clicking on the mouse facilitates accurate gel rectification. Furthermore, during all
procedures, typing “c” toggles the gel representation between grayscale and pseudocolor
representations.
8| Save the rectified gel image in .tiff format using the File-> Save Image dialog box. It is
also prudent to save the results acquired to this point by using the File-> Save Dump option.
<CRITICAL STEP> Saving your results periodically is very highly recommended.
Nat Protoc. Author manuscript; available in PMC 2009 March 7.
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9| Click “Assign Bands” to start the band assignment procedure. Band assignment provides
SAFA with the initial guesses required for fitting a peak model to each lane profile. Assign
the bands from the bottom of the gel to the top. The user is asked to input a starting band
number (labels on the top of the gel in the SAFA window) and will then click on the gel
image at the selected initial band position (Figure 2E). SAFA highlights bands by a colored
line (one color per base type). Depending on the selections made in Section 2a (iv), select
the positions for the bases moving up the gel.
<CRITICAL STEP> While SAFA does not limit the user's access to the bands at the top of
the gel, the program is far more likely to yield erroneous results for these poorly separated
bands. Limits to the extent of peak-fitting have not been coded into SAFA since gels vary
widely in quality and we do not wish to prevent users from extracting all possible information
from their gels. Users are advised to use common sense and to not try to over-interpret
individual gels. Multiple gels run for increasingly longer times remain essential to accurately
quantifying the band intensities of long fragments.
Quantitation
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10| Click “Quantify” to start the fully automated quantification procedure that determines
the density of each band. Following quantification, the user should save the spreadsheet
summarizing the results in a tab delimited text file. The first column in the spreadsheet is
the nucleotide numbers with the following columns containing the raw peak density data.
The user may use this spreadsheet to analyze their data as they see fit; it may be inspected,
graphed or output to another program. Step 11 describes the numerical transformations
included in SAFA typically conducted for equilibrium and time-resolved chemical
mapping experiments. Other normalization procedures are available through separate
modules that will be incorporated into future versions of SAFA
(https://simtk.org/home/nornalize).
Post quantification analysis
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11| The raw band intensities generated in step 5 may be normalized to correct for variation
in the amount of sample loaded onto the gel or small variations in extent of the chemical
mapping reaction among the samples. Choose a normalization strategy based on the nature
of the experiment and the ultimate goal of the analysis. Alternative strategies below that
can be accomplished within SAFA are accessed through the Visualize Data-> Normalize/
Colorplot menu option. These transformations can also be carried out in a spreadsheet
program. The options are (A) Invariant Residue Normalization and (B) Mean Protection
Normalization.
(A) Invariant Residue Normalization17
(i) Choose this option for titration and time-resolved experiments where the
goal is to observe a change in the protection value of single nucleotides as a
function of a specific variable. This approach yields relative changes in
protection and is ideal if the goal is to obtain a mid-point of a thermodynamic
titration or a rate constant of a time-dependent process. We illustrate an
example of this procedure in Figure 5.
(ii) The protocol identifies a specified fraction (generally 5%) of “invariant
residues” whose densities do not systematically change over the course of
the experiment. These are the bands that show the minimum systematic
change in protection in the experiment. Type the “t” option in the
Normalization dialog box to select the residues chosen by SAFA. The raw
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peak intensities are then divided by the mean intensity of these invariant
residues by SAFA.
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(B) Mean Protection Normalization
(i) Choose this option to estimate the degree of protection. In the case of •OH
footprinting, the degree of protection is correlated to the accessible surface
area (ASA) of the RNA26. This simple procedure works particularly well
for experiments where the average protection in a reference lane probing
unstructured RNA is less than 10% of the data lanes. In this case the mean
protection value is computed and all peak amplitudes are divided by it. This
approach is particularly useful for comparing protections among different
molecules.
Timing
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1.

Pre-analysis experimental setup: The time required to set up an experiment is highly
variable and depends on the experimental protocol and the user's experience in the
particular mapping technique. Prior to the collection of data, several benchmark
experiments should be carried out to assess the reproducibility of the quantified data.

2.

Importing the gel image and sequence files: 2 minutes. A sequence file is reusable
and thus must only be created once.

3.

Gel Rectification: 15-30 minutes, depending on the number of lanes and the
experience of the user.

4.

Band assignment: 10-20 minutes. The time taken to assign bands is dependent on the
choices made in step 2a. iv. This step is accelerated if the user is familiar with the
pattern in the sequencing lane(s), either by previous annotation on a printout of the
gel or by assigning bands in previous gels with the same nucleic acid sequence.

5.

Quantitation: SAFA takes about 30 seconds per lane to optimize the peak model on
a Pentium Processor with 1 GB of RAM.

6.

Normalization: 1-2 minutes depending on protocol.

The total time to quantify a gel is in general 20 minutes.
Troubleshooting
Additional troubleshooting guidelines
• Installation and compatibility issues are discussed in detail in the SAFA user manual
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(http://safa.stanford.edu). Due to the wide variety of image formats available, most
user inquiries reflect difficulty with obtaining sufficient contrast in the main image
window (Figure 4A). This problem typically results from a mismatch of the bit-depth
of the image. Users can correct this problem by toggling the visualization mode under
the Settings->Render SQRT image. Alternatively, the users can change the bit-depth
of the image in the software used to save the image.
•

A clear understanding of the relationship between the sequence file and the band
assignment procedure (Step 4) allows SAFA to be used for a variety of applications.
We provide a generic sequence file for SAFA (containing only As) in the
accompanying data that can be used to evaluate the utility of SAFA for particular
applications. The file can be imported and only A selected in the Sequence Dialog
box, allowing the user to select bands sequentially.
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The approach chosen for normalization greatly influences the results. We have found
that Mean Normalization (6a.ii.) is generally best for most applications. Invariant
Normalization generally is more reproducible and less sensitive to nuclease peaks in
the data. However, the results of this approach are critcally dependent on the choice
of invariants. For well-characterized RNAs with well defined invariant residues
(e.g. the L-21 T. thermophila group I intron14, 23, 27) Invariant Normalization is
advantageous.

•

Although SAFA can correct many experimental imperfections in a gel image, the
resultant data will only be as good as the quality of the underlying experiment and
image. For example, nuclease contamination will cause dark if not saturated bands
that can bias the data analysis, especially normalization. Experimental effort should
be expended in the design of experiments compatible with SAFA analysis and their
careful and clean execution. Over-exposure of the images (and therefore saturation
of the density signal) must be avoided. Higher variability is generally expected in the
upper regions of the gel where the peaks are more overlapping. The fact that gel
quantitation requires minutes to complete allows users to freely repeat their analysis
and establish the reproducibility of their results.

Anticipated Results
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We provide in the supplementary materials a SAFA output file. The file is a matrix of numbers,
with the first column the nucleotide number, and the following columns the data for each lane.
We also provide normalized results using both normalization techniques outlined in step 11.
In Figure 5 we show typical results obtained for a thermodynamic folding experiment of a large
RNA. In the top pane, the normalized •OH profiles are shown for various Mg2+ concentrations,
which can then be used to obtain thermodynamic parameters for the folding reaction (in this
case the Mg2+ mid-point).
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Figure 1.

Basic premise of the SAFA software. A) SAFA-rectified chemical mapping gel image for
quantitative analysis. In this case, a Mg2+ titration of the L-21 T. thermophila group I intron.
B) Peak model (gray line) fit to the profile of the gel (black line) during the quantitation
procedure. Regions of low, medium and high overlap are indicated. C) Expected outcome of
the protocol; raw peak amplitudes based on the gel image as a function of concentration and
nucleotide number. Using SAFA, a user can quantify the gel image in approximately 20
minutes.
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Figure 2.

Basic principles of gel rectification. A) The user defines lane boundaries by drawing a series
of red lines on the image. B) Linear interpolation is used to correct the gel image vertically.
C) The user identifies several anchor bands (as indicated by red lines). D) The anchor bands
are then used to rectify the gel image horizontally. E) The user assigns bands by clicking on
the gel image. These assignments are used as initial guesses for the peak model fitting.
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Figure 3.

Optimum layout for a gel to be quantified by SAFA. This layout complements the SAFA
algorithms and thus yields highly reproducible results. Note that the gel shown in Figure 1A
has this layout, but has been cropped to show only a single titration. This layout allows users
to run two experiments on a single gel and then analyze them independently.
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Figure 4.

Screenshot of the SAFA software and identification of the major software features. A) SAFA
main window dialog box. The analysis procedure is carried out by clicking on the different
buttons on the right hand side of the window as described in this protocol. B) Sequence Dialog
defines the behavior of the band assignment feature of the software.
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Figure 5.

Normalization scheme (Invariant Residue Normalization) applied to a Mg2+ titration of the
P4-P6 subdomain of the T. thermophila group I intron. In this case four invariant residues were
used to normalize the data (146 147 148 and 195) determined according to17. A) (Top Pane)
Raw peak areas as determined by SAFA for lanes corresponding to Mg2+ concentrations of
0.1, 0.3, 6, 11, and 100 mM (Green, Blue, Red, Cyan and Magenta, respectively). (Bottom
Pane) Data normalized using invariant residue normalization procedure. A reference lane (in
this case the Green data (0.1 mM Mg2+) is used and then a scaling factor is computed for all
the other data such that the differences of the invariant peaks are minimized. B) Titration curves
for Residue 182 and 213 based on the data in A showing the Mg2+ dependence of these two
Nat Protoc. Author manuscript; available in PMC 2009 March 7.
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protections. A Hill model is fit to the data with a cooperativity value (n=3) to obtain a midpoint
of 1.7 and 1.9 mM Mg2+ for residues 182 and 213, respectively.
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Table 1

Troubleshooting table.
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Problem

Cause

Solution

The gel file is open but is
black

The gel file is not located
in the appropriate
directory

Relocate the file under
the directory from which
you launch SAFA

The gel file is open but is
not clear and or black.

The bit-depth of the
image is not suitable for
the SAFA display

•

Change the bit-depth of the image in the software used to save the
image or in image editing programs such as Adobe Photoshop

•

Toggle the visualization mode under the Settings->Render SQRT
image

NIH-PA Author Manuscript

SAFA does not properly
guess the lanes when
pressing ‘g’

The contrast between the
two lanes and between
the bands in these lanes
is either too weak or too
strong

Manually define the
boundaries for these
lanes

The quality of the image
decreases after I clicked
on “Anchor lane”

At this point, the gel
image is simplified for
analysis, this is normal

Increase the bins per
lane option when clicking
on “Align Gel”

After I saved my aligned
gel, it switches back to its
unaligned state

Known Bug

SAFA needs to be reset
(under File/Reset
Application) or restarted
after each assignment, or
when loading new data

SAFA asks me to assign
bands in the wrong order

SAFA has two options to
assign bands: from 5’ to
3’ or from 3’ to 5’

Make sure the box
“Three-Prime label” in the Sequence window is
unselected if you assign
from 5’ to 3’ (and viceversa for 3’ to 5’)

When pressing “Z” after
having assigned all the
bands, SAFA does not
count all the bands

Known Bug

Restart SAFA and
reassign the bands from
the saved aligned gel file

After checking the text
file output from SAFA,
some peaks don't match
with the bands on the gel

Some bands were
misassigned (e.g. on the
top of the gel or in low
contrast regions)

Open the saved assigned
gel file and edit bands
using the “E” and “R”
keys. However, you may
need to run your samples
on a different gel.
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